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New model of the cheap chinese radio with oled display.
7900D - http://www.qyt-cn.com/en/pro_info152.html
Quadband - VHF:136-174MHz 、220-260MHz UHF： 350-390MHz 、400-480MHz
8900D - http://www.qyt-cn.com/en/pro_info152.html
Dualband - VHF:136-174MHz UHF： 400-480MHz
Cheap bugged chinese software
http://www.qyt-cn.com/en/download.html

Associated revisions
Revision 2846:a20166dd7bf5 - 02/19/2017 04:15 pm - Jim Unroe
[KT7900D] Add Support for QYT KT7900D and KT8900D Mobile Radios
This patch modifies the btech.py driver to prepare it to support a
new series of mobile radios that have an OLED color display.
Radio models initially supported:
QYT KT7900D (quad band)
QYT KT8900D (dual band)
New Model #4269

Revision 2847:b648fd3b5a38 - 03/06/2017 07:15 pm - Dan Smith
Images for #4269

Revision 2854:fd21a61b3026 - 03/07/2017 05:52 pm - Jim Unroe
[KT7900D/KT8900D] Correct Typo
This patch corrects a typo that incorrectly references the
KT8900D model when it should be the KT7900D model.
related to #4269
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Revision 2865:04f81d303485 - 03/17/2017 02:11 pm - Jim Unroe
[UV-25X2] Add Support for new BTech Color Display Mobile Radios
This patch modifies the btech.py driver to support additional
mobile radios that have an OLED color display.
Additional radio models supported:
BTech UV-25X4 (quad band)
BTech UV-25X2 (dual band)
BTech UV-50X2 (dual band)
New Model #4269

History
#1 - 12/01/2016 11:14 am - Pavel Milanes
- Status changed from New to Feedback
- Assignee set to Pavel Milanes
- Priority changed from High to Normal
- Chirp Version changed from 0.4.0 to daily

Hi Marco, do you have one of these?
If you follow the process of get a serial dump of the upload/download I can review it (post it here), this has a big chance of being just another QYT
KT-8900 clone...
73 Pavel CO7WT.

#2 - 12/01/2016 01:37 pm - marco rossi
- File reboot.txt added
- File mem read.txt added
- File mem write.txt added
- File option read.txt added
- File option write.txt added

Pavel Milanes wrote:
Hi Marco, do you have one of these?
If you follow the process of get a serial dump of the upload/download I can review it (post it here), this has a big chance of being just another QYT
KT-8900 clone...
73 Pavel CO7WT.

Hi Pavel, yes i do have one and you are right, i should have posted it before. Anyways here it comes:
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When you first open the program (UV4BAND_E_CPS) the radio reboot itself (the log is "Reboot Log")
You can edit the memories (mem read / mem write logs)
https://i.imgur.com/mah2HH7.png
And you can edit the options (option read / option write logs)
http://i.imgur.com/eAbJeTx.png
The program is the same for the 8900D and the 7900D.
Hope this can help you and let me know if you need something else!!
73's !!

#3 - 12/02/2016 04:30 pm - Jim Unroe
- File btech_kt8900d_1.py added

Try this as a proof of concept. Try to download from the radio. If successful, save and attach the image to this issue. Then try and upload. Do nothing
else.
To try this, enable "Enable Developer Functions" in the Help menu and then use Load Module in the File menu.
Jim KC9HI

#4 - 12/03/2016 01:27 am - marco rossi
- File QYT_KT8900D_20161203.img added

Jim Unroe wrote:
Try this as a proof of concept. Try to download from the radio. If successful, save and attach the image to this issue. Then try and upload. Do
nothing else.
To try this, enable "Enable Developer Functions" in the Help menu and then use Load Module in the File menu.
Jim KC9HI

So,
i first had to edit the file (nothing serious. On line 500 was missing the 'D')
http://i.imgur.com/A3DeB9c.png
It reads correctly:
http://i.imgur.com/5N0YNsP.png
http://i.imgur.com/H0DeOsr.png
It writes correctly:
http://i.imgur.com/HIlwTrK.png
But you can't insert any frequency due to "out of supported range":
http://i.imgur.com/9oenciL.png
http://i.imgur.com/j6Wzizm.png
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Besides that, works flawlessly. Good job !!
p.s dunno if you need it but i'm attaching the img file.

#5 - 12/03/2016 03:17 am - Jim Unroe
This was proof of concept to validate downloading and uploading. I don't have access to a KT-7900D or KT-8900D. I don't have a manual for either
radio and currently know nothing about them radio (band limits, power levels, etc). So did absolutely nothing to support the settings of these radios.
That is why I said to test downloading and uploading and "do nothing else".
Yes. The img file from a successful download will be very useful.
Jim

#6 - 12/03/2016 05:36 am - Jim Unroe
Marco,
Was this image from a KT-7900D quad band? Which radio do you have (or do you have both)?
Jim KC9HI

#7 - 12/03/2016 05:47 am - marco rossi
- File K7900-8900 En manual.pdf added

Jim Unroe wrote:
Marco,
Was this image from a KT-7900D quad band? Which radio do you have (or do you have both)?
Jim KC9HI

This image is from the KT-8900D. That's the only one i have. But i'm pretty sure the software/firmware are pretty similar, since even the original
software says 7900D.
Attached, you can find the En - manual.. ;)

#8 - 12/03/2016 05:58 am - Jim Unroe
Thanks for the manual. That will be useful as well.
Jim

#9 - 01/10/2017 10:41 am - Roy Helge Rasmussen
Anything I can do to help here? I just purchased one of these KT-7900D and it is a nifty little radio.
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#10 - 01/14/2017 02:55 pm - James Kaelin
I too have the 8900d and would rather use Chirp to program it.
Any thoughts on if/when it may be available?
Anything I can do to help?
Thanks!
James
Jim Unroe wrote:
Thanks for the manual. That will be useful as well.
Jim

#11 - 01/17/2017 02:50 pm - Jim Unroe
- Assignee changed from Pavel Milanes to Jim Unroe

All,
I've been making some really good progress on this issue.
Pavel,
I went ahead and changed the Assignee from you to me.
Jim KC9HI

#12 - 01/18/2017 05:36 am - Pavel Milanes
Hi Jim, by my guest.
I'm enrolled now on the Kenwood TK-280... the more deep I go, the more similar to the TK-27xG/76xG it's...
I will put a developer driver now to get a Chirp image for comparison.
Cheers, happy hacking, Pavel CO7WT.

#13 - 01/26/2017 02:42 am - Jim Unroe
- Status changed from Feedback to In Progress
- Target version set to 0.5.0

Still making progress...

#14 - 02/01/2017 03:35 pm - Jim Unroe
- File btech_kt8900d_test.py added
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Please give this driver a try. I would like some testing done and feedback as to are any issues.
I would also like to know if there is anyone with a QYT KT7900D that can supply the MCU-Version from the lower status display of the factory
software.
Jim

#15 - 02/03/2017 10:07 am - Ryan B
Testing now. Had to edit the file slightly(There's a stray double quote on line 1801), but after that it reads the channels I have programmed into it. I'll
program a few more into it with CHIRP and see how it goes.

#16 - 02/03/2017 10:31 am - Ryan B
- File radio-chirp.csv added
- File radio-correct.csv added
- File QYT_KT8900D_20170203.img added
- File radio-manufacturer.dat added

After closer examination, I think it's not quite reading things correctly on my KT-8900D. I've attached a set of files that hopefully has enough info to
track things down, or at least show that I'm misunderstanding how CHIRP does things.
The K6BEN channels appear to have the rToneFreq setting incorrect(Should be 100.0 on both receive and transmit), and the CRLA channels should
have no RX tone. Does TSQL mode mean that it uses cToneFreq for both RX and TX? Does Tone mean that there is no RX tone?

#17 - 02/03/2017 10:57 am - Ryan B
Okay, I should have read more of the documentation before playing with this... It does appear to be working correctly. I've added four channels with
CHIRP, and they read into the official software as expected.

#18 - 02/03/2017 01:52 pm - Jim Unroe
- File btech_kt8900d_test2.py added

Thanks for the feedback Ryan. I have attached an update that removes the stray (").
Jim

#19 - 02/06/2017 12:22 pm - Kevin Buchholz
Hello, I'm new to all this. I've used Chirp for lots of radios but they have always been supported already... Those .py .dat etc files, how do you use
them? Am I reading this correct that people are getting it to work with the 8900D as long as you do something which I seem to be missing... I hate the
factory software and am looking forward to chirp on this model... If this is obviously over my head I guess I'll just wait till the bugs are worked out and a
chrip update is ready..
Kevin
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#20 - 02/07/2017 05:22 pm - Jim Unroe
- File btech_kt8900d_test3.py added

Any QYT KT7900D owners out there? I believe that this test driver may add support for the KT7900D. Please try and provide feedback.

#21 - 02/08/2017 07:25 am - Scott Mead
Sorry to jump in I have a Mini KT 8900D and would like to try this out but I am windows only.

#22 - 02/08/2017 07:57 am - remi f1mqj
Hi, i got one and would like to test drivers you made (thanks guys for working on), i run windows and try the load module, but it doesn't work,
I've seen this page for developers : http://chirp.danplanet.com/projects/chirp/wiki/DevelopersAdd_a_Radio but i want only test,
is there some page showing how to load test drivers in windows ? or only in linux ?
73's and thank you

#23 - 02/08/2017 03:00 pm - Jim Unroe
All you need is a working installation of a recent CHIRP daily build. It does not matter what OS is installed on your computer. How to use this driver
module was covered in Note #3. Here is the procedure in more detail.
To download the driver module:
Click the driver module link (right-clicking the link and choosing "Save Link As..." will not work)
Once the next page appears, click the "download" link
Save the file anywhere convenient (I recommend saving to the folder where you keep your CHIRP Radio Images (*.img) files)
To load the driver module:
Click "Help" in the menu bar
Enable "Enable Developer Functions"
Click "File in the menu bar
Click the "Load Module" developer function
Locate and load the driver module that was saved earlier
Now you will be able to test programming your QYT KT7900D and/or KT8900D with CHIRP
Note: Loading the special driver module does not change your CHIRP installation in any way. After you close CHIRP, you will have to load the drive
module again before you can test programming the new radios or load saved image files.

#24 - 02/08/2017 05:08 pm - Jim Unroe
- File btech_kt8900d_test4.py added

Here is an update that fixes an issue for the KT7900D.
Jim KC9HI
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#25 - 02/08/2017 05:28 pm - Kevin Buchholz
Linux and windows 10 when I load module and select any of the test.py files I get an error which says Unable to load module : invalid syntax (the file
name, line1)

#26 - 02/08/2017 07:48 pm - Scott Mead
I was able to get my radio programmed with test4. Compared to the stock program chirp took about twice as long to download/upload to the radio.

#27 - 02/09/2017 02:42 am - Jim Unroe
Kevin Buchholz wrote:
Linux and windows 10 when I load module and select any of the test.py files I get an error which says Unable to load module : invalid syntax (the
file name, line1)

Because you downloaded the web page instead of the driver module file. Go back and read "To download the driver module:" in Note #23.
Jim

#28 - 02/09/2017 08:46 am - Alastair Smith
- File debug.log added

Debug log file attached as requested for the KT-7900D showing nothing under the settings tab.

#29 - 02/09/2017 04:52 pm - Kevin Buchholz
Jim Unroe wrote:
Kevin Buchholz wrote:
Linux and windows 10 when I load module and select any of the test.py files I get an error which says Unable to load module : invalid syntax (the
file name, line1)
Because you downloaded the web page instead of the driver module file. Go back and read "To download the driver module:" in Note #23.
Jim

Opps, my bad. Yep that got it. Read and wrote fine just really slow.

#30 - 02/09/2017 06:23 pm - Jim Unroe
Would one of you QYT owners attach 2 images with only the "Ring_Time" different so I can locate that setting in memory? You will have to use the
QYT software to do this. Upload to the radio and download to chirp. Save to image. Change the "Ring_Time" setting and repeat.
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Thanks,
Jim

#31 - 02/09/2017 08:26 pm - Scott Mead
- File QYT_KT8900D-ring time 3-.img added
- File QYT_KT8900D-ring time 10-.img added

Here they are from mine.

#32 - 02/10/2017 03:27 am - Jim Unroe
Thanks Scott. Now I have a question. What is menu 25 in the KT7900D and KT8900D radios?

#33 - 02/10/2017 03:36 am - Jim Unroe
- File btech_kt8900d_test5.py added

This should eliminate the blank settings until I learn more about the QYT radios. Thanks for the assistance.
Jim

#34 - 02/10/2017 10:42 am - remi f1mqj
Thanks for tip (dont make save as but clic, then clic on download .py) works fine now for me (usefull to put in an FAQ ...)
I've got one and try some test :
Menu 25 is said SIG-BP, and looks located at 0E19
FM receiver frequencies looks to be at 0FF0-1-2-3-4
Thanks for job, ask if you need tests

#35 - 02/14/2017 06:43 pm - Joshua Grubman
Jim: I wanted to leave a note on this case to let you know I loaded 'btech_kt8900d_test5.py' into Chirp and had immediate success importing my
channel program into my new KT-8900D. One issue worth noting is that it takes an incredibly long time to update the radio. The same is true for my
KT-8900 (slightly older cheapo Chinese radio, a little smaller and lacking the 'D' model's OLED display), so I'm guessing it has something to do with
the radio or the bootleg PL2303 USB serial cable I'm using, as opposed to an issue with CHIRP itself. In any case, I'll continue testing updates as you
make them available. Many, many thanks for all your hard work!

#36 - 02/15/2017 03:22 pm - remi f1mqj
Joshua : time for me is about 40s reading, 1'20" writing
Jim : about TMR (menu 0, settings Transceiver Multi Receive) configuring A+B+C+D in chirp results in none on transceiver, changing to ABCD on
radio result in changing 0E00 from 0F (not OK) to 0E (works fine for ABCD Monitoring)

#37 - 02/15/2017 04:55 pm - remi f1mqj
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Bugs found in the Transceiver firmware (don't hesitate to confirm/deny/add others):
-switching from memory to VFO mode (push V/M) doesn't work (or very badly)
-TMR (multi standby) work bad in VFO mode (displaying signal receive but no sound)
-reverse function (* on micro) doesn't work
-transmitting on ham UHF relay with call tone generate after release PTT a small wait time (1/2 sec) then another transmit (without pushing anything)
then receive (makes problem on each "line" ABCD), looks to hapen when we release PTT before Call(or simultaneously), the best way seems to
release call, then release PTT

#38 - 02/15/2017 05:40 pm - Jim Unroe
TMR programs fine here with the radios that I am working with. Unfortunately I do not have a KT7900D or KT8900D. This is why I ask questions and
request feedback regarding the QYT radios.
I believe this may be a bug in your radio. There should be 16 settings for TMR corresponding to 00 through 0F in my radios. How many selections for
TMR does your radio have?
In my radios, 0F is A+B+C+D and 0E is M+B+C+D. Only when the A line is selected as the main channel would the A+B+C+D and M+B+C+D
selections function the same.
I noticed that the factory software also has a bug regarding the TMR setting. It is missing the M+A+C+D setting so it only has 15 choices. Could this be
because the software matches the the radio which is missing one of the selections?
The full list of 16 valid TMR selections are:
OFF, M+A, M+B, M+C, M+D, M+A+B, M+A+C, M+A+D, M+B+C, M+B+D, M+C+D, M+A+B+C, M+A+B+D, M+A+C+D, M+B+C+D, A+B+C+D
Jim

#39 - 02/15/2017 05:44 pm - Jim Unroe
Please refrain from posting bugs about the transceiver firmware here unless it directly affects the programming of the driver. It adds unnecessary
noise.
Jim

#40 - 02/17/2017 09:31 am - Alastair Smith
- File KT7900.jpg added

TMR KT-7900D

#41 - 02/17/2017 09:40 am - Jim Unroe
Alastair,
What are you trying to point out with this picture? It looks good to me. Exactly matches my radios.
Jim
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#42 - 02/17/2017 12:37 pm - remi f1mqj
- File TMR8900_logOrig.jpg added

Here is mine for 8900 (original programming software), there is only 15 (no M+ACD or no A+B+C+D)

#43 - 02/17/2017 01:07 pm - Jim Unroe
The factory software is incorrect. What does the radio have for TMR? Mine has the 16 settings that I stated above and CHIRP matches it exactly. If
your radios do not have 16 settings, then TMR is not implemented correctly in them.
Jim

#44 - 02/17/2017 01:39 pm - Alastair Smith
Sorry, thought you asked earlier in the thread for confirmation. Just delete the post and this one. Is there any further that you need?

#45 - 02/17/2017 02:19 pm - Jim Unroe
What I want confirmation of is the number of selections for TMR in the KT7900D and KT8900D radios. That is what is important. It is already confirmed
the factory software is "broken" in this regard.
I need to know if the QYT radios are short one selection or not (15 or 16). And if they are short on selection, which one is missing?
I believe I also asked what is menu 25 in the QYT radios?
Jim

#46 - 02/18/2017 10:12 am - Alastair Smith
Menu 25 is SIG-BP, both in the radio itself and also listed in the manual, signalling available prompt on/off.
Radio TMR. M+A+B+D is not on the radio menu.

#47 - 02/18/2017 11:35 am - Jim Unroe
Alastair,
Thanks for the feedback...
Thanks for confirming that menu 25 (SIG-BP) is the same as the radios that I have. Since I do not have the QYT color radios, I wanted to be certain
because the QYT factory software incorrectly programs the "Roger Beep" (SIG-BP) memory location as "Ring_Time" (RING-T).
Thanks for the confirmation of the missing selection in the radio's menu 0 (TMR). It is odd that the radio is missing a different selection (M+A+B+D)
than in the factory programming software (M+A+C+D). The error has been corrected in my radios. I wonder if it will be corrected in QYT radios? It
would be nice if others can report if menu 0 (TMR) of their radio has only 15 selections or the correct 16 selections.
Another test that would be helpful would be to confirm if menu 25 (SIG-BP) works in the QYT radios. On all of the 3 radios that I have, ON is the same
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as OFF. In other words, the Roger Beep does not work (which to me is a good thing, LOL).
Jim

#48 - 02/18/2017 11:45 am - Walter Francis
Here is the full, ordered list of 15 items in my TMR on my 8900D. And BTW, I'm 99% sure SIG-BP is NOT Roger Beep; it's ANI stuff. If someone
sends a DTMF tone to you. I've never messed with 2/5 tone stuff so I'm not sure of the use cases.
Off
M+A
M+B
M+C
M+D
M+A+B
M+A+C
M+A+D
M+B+C
M+B+D
M+C+D
M+A+B+C
M+A+C+D
M+B+C+D
A+B+C+D

#49 - 02/18/2017 11:59 am - Walter Francis
Sorry for the spam, I had not tried the test5 driver yet.. My radio is set to A+B+C+D but Chirp shows it as M+B+C+D. Just FYI, if this is the worst
that's wrong it's not the end of the world. I found it odd the screen flickers the whole time it's downloading the image from it, it doesn't do that on the
OEM software.
BTW, Alarm Mode, the "Alarm" setting does NOT TX, as far as I know, so just "Alarm Sound" makes sense for that one.
The other things, so far, look good! I have not tried to upload an image to the radio yet. Is that safe to do? At worst I could always reflash my image
from the OEM software? If so I'll be happy to help test in any way I can.

#50 - 02/18/2017 12:12 pm - Jim Unroe
Also, would someone with a KT7900D submit an image from it? A "factory" image or after a RESET would be great.
Thanks in advance.
Jim

#51 - 02/18/2017 12:17 pm - Jim Unroe
Walter Francis wrote:
Sorry for the spam, I had not tried the test5 driver yet.. My radio is set to A+B+C+D but Chirp shows it as M+B+C+D. Just FYI, if this is the worst
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that's wrong it's not the end of the world. I found it odd the screen flickers the whole time it's downloading the image from it, it doesn't do that on
the OEM software.
BTW, Alarm Mode, the "Alarm" setting does NOT TX, as far as I know, so just "Alarm Sound" makes sense for that one.
The other things, so far, look good! I have not tried to upload an image to the radio yet. Is that safe to do? At worst I could always reflash my
image from the OEM software? If so I'll be happy to help test in any way I can.

Save your first successful CHIRP download from your radio, unedited, to a CHIRP Radio Images (*.img) file. You can then use that file later to return
the radio back to that state should something unusual happen.

#52 - 02/18/2017 12:38 pm - Walter Francis
Jim Unroe wrote:
Save your first successful CHIRP download from your radio, unedited, to a CHIRP Radio Images (*.img) file. You can then use that file later to
return the radio back to that state should something unusual happen.

Cool! I wasn't sure how stable saving would be. Good deal. I can always rewrite with the OEM software too, I typed everything into there over the
past two days thinking this driver wasn't as complete as it was.
Are you looking for any feedback on other things, such as BCL missing in Frequency and Settings. There are other non-ham stuff missing too, which
may or may not matter. Thank you so much BTW!!

#53 - 02/18/2017 01:09 pm - Jim Unroe
Walter Francis wrote:
Are you looking for any feedback on other things, such as BCL missing in Frequency and Settings. There are other non-ham stuff missing too,
which may or may not matter. Thank you so much BTW!!

BCL is not missing! Click a memory row to highlight it. Then click the [Properties] button. (an alternative to the previous 2 steps would be to right-click
the memory row and choose "Properties" from the dialog box that appears) Finally in the "Memory Properties" editor window, choose the "Other" tab.
You will find Busy channel lockout (BCL) along with Scramble, PTT ID, PTT ID signal code, Optional signaling and Speaker mute.
Jim

#54 - 02/18/2017 02:31 pm - Walter Francis
Jim Unroe wrote:
BCL is not missing! Click a memory row to highlight it. Then click the [Properties] button. (an alternative to the previous 2 steps would be to
right-click the memory row and choose "Properties" from the dialog box that appears) Finally in the "Memory Properties" editor window, choose the
"Other" tab. You will find Busy channel lockout (BCL) along with Scramble, PTT ID, PTT ID signal code, Optional signaling and Speaker mute.
Jim
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DRAT! I missed the "Other" tab entirely. That explains that! Thank you :) I've downloaded, modified, and uploaded to my radio several times now,
I've seen no problems, this is great stuff. I wish I'd tried it the last two days instead of using the OEM software.

#55 - 02/18/2017 02:59 pm - Alastair Smith
- File KT7900DRESET.dat added

KT-7900D factory reset Dat file from factory software and CHIRP Img.
I did notice that even after the full reset, my call sign was kept as the welcome message.
I also checked MABD in my radio to the Chinese software and it is different in the software, but definitely MABD on the radio missing.
I haven't had a chance to give a local a call yet to check out the RB and I do not fancy going on the calling channel and asking how my Roger Bleep
sounds with a full call sign.

#56 - 02/18/2017 05:52 pm - Jim Unroe
Alastair Smith wrote:
KT-7900D factory reset Dat file from factory software and CHIRP Img.

I guess I wasn't clear. I want a CHIRP image from a KT7900D.
Jim

#57 - 02/19/2017 04:04 am - Alastair Smith
- File KT7900DRESET.img added

I'm not sure what happened there then, because I attached both. Here is the img file that should have been with it.

#58 - 02/19/2017 04:04 am - Alastair Smith
- File KT7900DRESET.img added

I'm not sure what happened there then, because I attached both. Here is the img file that should have been with it.

#59 - 02/19/2017 05:35 am - Jim Unroe
Thanks you very much Alastair. I have it now!
Jim

#60 - 02/19/2017 08:09 am - Jim Unroe
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Would someone please submit a CHIRP Radio Images (*.img) file from a KT8900D that has been RESET (or otherwise sanitized to not have any
personal information)?
Thanks,
Jim

#61 - 02/20/2017 03:13 am - remi f1mqj
- File QYT_KT8900D_20170220_after_Reset.img added

Hi here is a KT-8900D image after reset all (menu 57 (all), menu, menu)
Hope this can help
BCL (Menu 15) tested : works OK in VFO Simplex without TMR (stay OFF in memory mode)
Loks like some Menu are NotAvailable on Memory mode ...
Updates on what i've previously called Bugs :
Not a bug : I badly understand VFO mode-totaly independant of Memory channel previously displayed (switching from memory to VFO mode (push
V/M) doesn't work (or very badly)
-TMR (multi standby) work bad in VFO mode (displaying signal receive but no sound)> obviously TMR not realy made for VFO Mode
-reverse function (* on micro) doesn't work -> Reverse function can only work without TMR, after been said it's logic, but not obvious at first sight
-transmitting on ham UHF relay with call tone generate after release PTT a small wait time (1/2 sec) then another transmit (without pushing anything)
then receive (makes problem on each "line" ABCD), looks to hapen when we release PTT before Call(or simultaneously), the best way seems to
release call, then release PTT
New bug seen : Menu 43 TXDISP : either in Power or Mic-V show same (varying with sound -> looks like mic-V)
No CTSS or 2-5 tone here, not easy to test ...

#62 - 02/20/2017 03:56 am - marco rossi
remi f1mqj wrote:
Hi here is a KT-8900D image after reset all (menu 57 (all), menu, menu)
Hope this can help
BCL (Menu 15) tested : works OK in VFO Simplex without TMR (stay OFF in memory mode)
Loks like some Menu are NotAvailable on Memory mode ...
Updates on what i've previously called Bugs :
Not a bug : I badly understand VFO mode-totaly independant of Memory channel previously displayed (switching from memory to VFO mode
(push V/M) doesn't work (or very badly)
-TMR (multi standby) work bad in VFO mode (displaying signal receive but no sound)> obviously TMR not realy made for VFO Mode
-reverse function (* on micro) doesn't work -> Reverse function can only work without TMR, after been said it's logic, but not obvious at first sight
-transmitting on ham UHF relay with call tone generate after release PTT a small wait time (1/2 sec) then another transmit (without pushing
anything) then receive (makes problem on each "line" ABCD), looks to hapen when we release PTT before Call(or simultaneously), the best way
seems to release call, then release PTT
New bug seen : Menu 43 TXDISP : either in Power or Mic-V show same (varying with sound -> looks like mic-V)
No CTSS or 2-5 tone here, not easy to test ...

Hi,
you found out all those bugs, but does your scan function works ?
https://www.youtube.com/watch?v=IEXZnTMWSxs
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#63 - 02/20/2017 09:35 am - Jim Unroe
I submitted a patch last evening. It is quite an extensive update so there is a chance that there may be questions asked or suggestions offered on how
to make it better. We'll have to wait and see how it goes.
Jim KC9HI

#64 - 02/20/2017 10:17 am - Walter Francis
Jim Unroe wrote:
I submitted a patch last evening. It is quite an extensive update so there is a chance that there may be questions asked or suggestions offered on
how to make it better. We'll have to wait and see how it goes.
Jim KC9HI

AWESOME work Jim, thank you so much. I did a ton of adding, updating, removing, and arranging channels on my 8900D yesterday (my repeater list
was years old, I had just been inputting the same list into each radio over the years basically) and I had zero problems. I haven't dived into settings
deeply but typical channel organization went flawlessly.

#65 - 02/20/2017 12:16 pm - remi f1mqj
Hi Marco, no scan problem at all, is there a release rev number somewhere ? i've a serial number starting like a manufacturing date : 161128
I've also found it can make cross band (VHF/UHF) repeater (offset 288...MHz)
I'm looking to see if it can do transponder (receiving on one band and transmitting on the other), probably not with only one antenna(yaesu FT470 did
it) but REP-M Menu (51) talk about transpond (but seems only to be a Voice allowing output : if OFF or CAR, you get sound if on frequency,

#66 - 02/20/2017 12:26 pm - marco rossi
remi f1mqj wrote:
Hi Marco, no scan problem at all, is there a release rev number somewhere ? i've a serial number starting like a manufacturing date : 161128
I've also found it can make cross band (VHF/UHF) repeater (offset 288...MHz)
I'm looking to see if it can do transponder (receiving on one band and transmitting on the other), probably not with only one antenna(yaesu FT470
did it) but REP-M Menu (51) talk about transpond (but seems only to be a Voice allowing output : if OFF or CAR, you get sound if on frequency,

My serial number is 1609182122 and the board is marked "XTJ_LY_RP_CP_4.2" "2016_08_31".
Mine have this problem and the cross band repeater function doesn't work. Obviusly the manufacturer doesn't answer to emails. And sent it back to
china it'd cost half the radio price..
Soo happy.. :)

#67 - 02/25/2017 06:59 am - marco rossi
Jim Unroe wrote:
I submitted a patch last evening. It is quite an extensive update so there is a chance that there may be questions asked or suggestions offered on
how to make it better. We'll have to wait and see how it goes.
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Jim KC9HI

Hello,
i've been away from this thread.
Is it normal that setting page isn't available yet ? http://i.imgur.com/QWcJYzF.png
All test file are the same. Memory works great but i have nothing under setting.
This appends with all python test files. Using windows or linux is the same. (It works fine on UV4 QYT Software)
Thanks

#68 - 02/25/2017 07:35 am - Jim Unroe
Most likely a setting that is out-of-range. I won't know which one until you provide a debug.log file or the downloaded .img file.
Jim

#69 - 02/25/2017 07:51 am - marco rossi
- File debug.log added
- File QYT_KT8900D_20170225.img added

Jim Unroe wrote:
Most likely a setting that is out-of-range. I won't know which one until you provide a debug.log file or the downloaded .img file.
Jim

Hi,
this is my debug.log and .img file just after a reset.
Thanks for the help..

#70 - 02/25/2017 07:56 am - marco rossi
EDIT I just fixed the problem writing the "QYT_KT8900D_20170220_after_Reset.img (16 kB) remi f1mqj, 02/20/2017 03:13 am" image.
Now it reads fine.. ;)

#71 - 03/07/2017 02:27 am - Jim Unroe
Today's CHIRP daily build should have QYT KT-8900D and KT-7900D support.
Jim

#72 - 04/13/2017 07:51 pm - Scott Mead
In using this i found no option to set wide or narrow band per frequency. Did i miss something? I had to use the oem software to do it.
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#73 - 04/14/2017 01:12 am - Jim Unroe
The Mode column.
FM = Wide
NFM = Narrow
Section 6 of this page has links to at least 2 column guides for CHIRP.
Jim

#74 - 04/14/2017 05:07 pm - remi f1mqj
1 - I've found on Miklor a new revew on Btech 25X2 / 25X4 which looks exactly like KT8900D/7900D and are included in last Chirp build (20170414),
are firmware and data exchange the same ? so debugging could be mutual
http://www.miklor.com/COM/Review_25X24.php
2 - on the manual, menu 51 REP-M speaks about transponder,
what i understand as transponder is receiving BF on one band, and simultaneously transmit this BF on the other band (very usefull to repeat for
example a relay received on high antenna shack in the neiborhood to listen it in the garden with a little pocket)
Does some of you made transponder mode working ? if yes, how ? because i tried without reaching success
Remi

#75 - 07/05/2017 06:11 pm - Jim Unroe
- File BTECH_UV-25X2.img added
- File BTECH_UV-25X4.img added
- File BTECH_UV-50X2.img added
- Status changed from In Progress to Feedback

The factory images for the BTECH UV-25X2, UV-25X4 and UV-50X2 were submitted back in March but so far have not been included in the CHIRP
repository. I will look into getting them added again but in the mean time I will add them here.
Jim KC9HI

#76 - 07/05/2017 06:12 pm - Jim Unroe
- Status changed from Feedback to Closed
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